Reports - running and scheduling reports

This ROSS User Guide explains how to run Standard and User Community
Reports available in ROSS Reports via the ROSS Reports Portal. Topics include:

e Getting started

e Working with Standard Reports

*  Working with User Community Reports

e Saving report results in another output format
e Scheduling Report Views

¢ Troubleshooting.

The ROSS Reports Portal is the gateway to all available Standard and User
Community Reports.l

Getting started
The section explains basic information you need to access ROSS Reports,
including:
e Loggingon
e Logging off
e Setting up your default time preference
e Viewing reports in List View or Details View.
Logging on
You have two options for logging on to ROSS Reports:
e From ROSS you will go directly to the ROSS Reports Portal.
e From the Internet you will bypass ROSS and go directly to the Public
Folders Portal. From here, drill down to the ROSS Reports Portal.
To log on to ROSS Reports from the ROSS application
o Select Reports at the menu bar then click Reports Portal.

1.This document is based on information, concepts, and instructions available in, “IBM Cognos Connection Version 10.2.1.1: User
Guide.” © Copyright IBM Corp. 2005, 2013.
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To log on to ROSS Reports from the Internet
Start your Internet browser.

In the Address bar, type https://rossreports.nwcg.gov/.

In the User ID text box, type your Standard NAP User Account Name.
In the Password text box, type your NAP Password, and then click OK.
On the Public Folders Portal, click ROSS.

On the Public Folders > ROSS Portal, click Portal Pages.
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On the Public Folders > ROSS > Portal Pages Portal, click ROSS.

Note: To set Home page to a desired location while on that page click arrow next
to the home Icon and select Set as Home Page.

The following graphic shows the Log on dialog box.

Log on
Please type your credentials for authentication.

i

5 Y /rq\,’“\
PG Hamespace:

[l
f' - w | ROSS Users

User 1D:

o o]

Licansed Materisks - Property of IEM Corp.

b

ROSS Reports Portal page

ROSS ‘ROSS - ariginal toy Folders cl
HEmE R | seorehoreporis AEmE

- g
e O N T NG 1)

| Actions

Erp®E

i

li]
v

i i i i i
HYVYYYVYYVVY

F PP // /PP /S

@em,ee:g

i
LAAAAAAAL
PPPPPV //.

i

i i (i i 3

vy
(L

monoonoonononon
LAAAAAZAZAL

| Qe dLadd 444
e@@e@eeeee

version 2.16.11 September, 2018


https://rossreports.nwcg.gov/

ROSS User Guide Reports - running and scheduling reports

Logging off

Logging off will end your session in ROSS Reports. Closing your Internet
Explorer window will also end your session.
To log off ROSS Reports
1 On the ROSS Reports Portal page, click Log Off.
2 Close Internet Explorer.
The following graphic shows the ROSS Reports Portal page. The arrow points
to Log Off.
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Setting your default time zone preference

The time zone determines when any scheduled reports will run. Be sure to
specify the correct time zone for your area and needs.

To set your default time zone preference
1 On the ROSS Reports Portal page, click the Home icon.

= 2 IBM Cognos Connection toolbar, click the My Area Options drop-down
arrow, and then click My Preferences.

3 Under Time zone, perform the following

- click Use the following time zone

- click the Time zone drop-down arrow, and then click the Time zone
of your choice then click OK.

- If My Area Options is not visible click on any small blue arrow to
expand a panel. The icon will appear next to the Home Icon.

The following graphic show the IBM Cognos Connection toolbar. The arrow
points to the My Area Options drop-down arrow.
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The following graphic shows the Set preferences screen. The arrow points to
the Time zone field.

Set preferences Help ()
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Number of entries in list view: Report format:
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Separators in list view: [¥] Show the Welcome page at startup
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Style:
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Default view:
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Viewing reports in List View or Details View

The first two buttons on the toolbar allow you to customize the information
displayed in ROSS Reports:

e List View, the first button on the toolbar, displays Folder Names and
Report Names only. List View is useful when you are familiar with the
reports that are available.

Details View, the second button on the toolbar, displays Folder Names,
Report Names, and descriptions. Details View is useful when you need
more information before choosing which report to run. Details View also

completes the Description box when you create a shortcut or Report
View.

To view Folder Names and Report Names

e On the toolbar, click the List View button.

version 2.16.11 September, 2018
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The following graphic shows the Public Folder > ROSS > User Community
Reports Portal page in List View. The arrow points to the location of the List
View button.

s://rossreportsnweg.gov/cognos/es O = @ ©'] 7 public Folders - 1BM Cogno. D

1BM Cognos Connection

[f  Public Folders My Folders

Public Folders > ROSS > User Community Reports =3 S EEI

Name ¢ Modified ¢ Actions

UC - Administration December 8, 2010 8:37:57 AM More.

UC - Resources December 8, 2010 7:37:41 AM 1 more...

L]
(]
O IC - Incidents May 8, 2013 7:38:57 AM O ore...
O
L

SR ALIG TG 4ttt P S A o~ tnnnafN BERETDET 8, 2010 7:37:59 Ao s, LA, 40 >
- m'«_)'«-«,»‘m‘»-‘/ AL AA“;‘AAA'*" wah st A‘«//

To view Folder Names, Report Names, and descriptions

e On the toolbar, click the Details View button.

Working with Standard Reports

Standard Reports provide quick and easy access to critical information in
support of national management functions and decision-making. Topics in
this section include:

e Overview

e Completing Standard Report Criteria Blocks
e (Creating a Report View

e Creating a shortcut to a report.

Overview

Some key points about Standard Reports include:

e Standard Reports are pre-defined and are fixed in format. You cannot
change the layout.

e By default, all Standard Reports are generated in PDF format.

¢ To manipulate columns and rows of report results, change the output
format of the report to CSV. Selecting this output format will download
the file to your computer. The report results do not display on your
screen.

e To quickly access a report you use often, create a shortcut in My Folders.

e To save a PDF of your report results, you can Keep this version, then save
the report as a Report View in My Folders.

¢ To change filter criteria of a Report View, click the Run Report button.
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The following graphic shows the location of Standard Reports on the ROSS
Reports Portal. The arrows point to the locations of Standard Reports
(Current) and Standard Reports (Historical).
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Completing Standard Report Criteria Blocks

Filter criteria for Standard Reports is organized and displayed into Criteria
Blocks. Each Criteria Block lists related information in a top-down,

left-to-right sequence. The more filter criteria you provide, the faster the
report will run.

To specify the data for your report

1 Locate the Standard Report of your choice.

2 Click the first () to open the first Criteria Block.

3 Complete the first field in the first Criteria Block.

4 Click the Filter button, then select one or more of the results.
5 Click the next ( ) to open the next Criteria Block.

6 Continue completing all required Criteria Blocks, selecting the results to
further refine your report.

7 When finished selecting all filter criteria, click the View Report button.
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The following graphic provides an overview of screen components for
completing filter criteria for a Standard Report.

Criteria Block

selected criteria

filtered results

Clear Filters button

text box

Clear Filter

Filter button
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COLORADO OEM ONLY V| |ACCOUNTANT (AGHEALTH) v
Groups |ACCOUNTING TECHNICIAN
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Incident Name | Incident Type [**AIF* I Fitter
Incident Number | Incident Host [ Ticident Dispatch [CO*
I~ External ony Incident [Number] Name*
[KS-HOA-000188] Simon
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} Resource Ordering and Status System Reports

Filter Criteria:
Catalog = Overhead

Request List

More than 10 Incidents Cannot Be Displayed In the Filter Criteria. The selected Incidents wil be reflected in the body of the Report.

Dispatch: CO-CRC/ Craig Interagency Dispatch Center

Request | Requesttatus | Requested ftem Q| Resource Assignment Neme Resource Status | Special Needs
Number
Incdent: BLACKWALL
01 Reassigned ENGINE BOSS (ENGB) | 1 s A (CO-CRO) () Reassigned Reportto & in Meeker Station
9 (CO-CRO) A-A)
Incdent: TWIN WASH
01 Released TECHNICAL SPECIALIST (THSP) 171 Mt Sugn (€O-RO NR: g mmss, to assst DV 11
Dispatch: CO-DRC / Durango Interagency Dispatch Center
Request | Requeststatus | Requested ftem Q| Resource Assignment Name Resource Status | Special Needs
Number
Incident: Freeman Ridge
o1 Released Modue, Widand Fie, Type 1 171 MODULE. WIDLAND FIRE-RM - Released
COLUMBINE - T-1 (CO-DRO) (CO-DRO)
Incident: SAN JUAN NF ABCD MISC 2013
o1 Reassigned AR TACTICAL GROUP SUPERVISOR 11| T SHCODRO | Reassigned ATGS: N-248CP
@Tes)
02 Released AR TACTICAL GROUP SUPERVISOR no . (4 (CO-DRD)  Released
T6S) on
(©0-0R0)
03 Reassigned TIME UNIT LEADER (TiM) v ¥ (€0-0RO) EFF/AD] Reassigned
o4 Deleted SECURTY SPECIALIST-LEVEL2 GECD) | 1/0 Deleted
os Released AR TACTICAL GROUP SUPERVISOR 1 3(CO.0RD)  Released
@res)
os Reassigned AR TACTICAL GROUP SUPERVISOR 11| s A (CO-DRO) Reassigned
o7 Released HELICOPTER CREWMEMBER (HECM) 1 S W (NM-ADC) Released
(€O-DRE) T-4)
os Released HELICOPTER CREWMEMBER (HECM) 1 (€0-080) Released

To clear Criteria Blocks

1

To clear all Criteria Blocks, click the Clear Filters button.

2 Toclear anindividual Criteria Block, click Clear Filter that corresponds to
the Criteria Block you want to clear.
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Creating a Report View

For Standard Reports, saving a Report View in My Folders allows you to save
the report results as well as specifications of the original report, including

queries, prompts, layouts and styles.

To change the filter criteria, you can the run properties of the Report View,
including prompt values, schedules, delivery methods, and output formats.

You can also schedule Report Views to run on a regular basis. For more
information see Scheduling Report Views.

To create a Report View of your report

1
2

Run the Standard Report of your choice.

Click the Keep this version drop-down arrow, and then click Save as

Report View.

On Save as report view, type the Name of Your Report in the Name text

box.

Under Location, click Select My Folders, and then click OK.

The following graphic shows a sample Resource Status Detail By Qualification
report. The arrow points to the Save as Report View option.
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Filter Criteria:
Dispatch = Craig Interagency Dispatch Center
Catalog = Overhead
Category = Positions
Catalog Item = ENGINE BOSS, ENGINE OPERATOR
Qualification Visibility = Visible

iiReport.. 1
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Catalog | Category Qual Status Qualification Qual | status Area Avalable To | Resource Provider/ Owner/ Home Unit Location
Visible.
Overhead | Positions Qualified ENGINE BOSS Yes  Available GACC Colorado Department of Public Safety | CRAIG-MOFFAT
(€O-60) (CO-COPS) (€AG)
DFPC - Grand Junction Area Office
(CO-GI5)
DFPC - Grand Junction Area Office
(€O-GJS)
Yes | Available Local P DFPC - Crai Area Office (CO-CRS) State Office - CO
(€O-CRO) State Office - CO State Forest Service  State Forest
(€0-COs) Service (CO-COS)
State Office - CO State Forest Service
(Co-Cos)
Yes  Available Local State Office - CO State Forest Service | Steamboat
(CO-CRO) (€0-C0S) Springs District -
DFPC - Crai Area Office (CO-CRS) €O tate Forest
Steamboat Springs District - CO State | Service (CO-55DS)
Forest Service (CO-55D5)
Yes  Available Local Western Slope Center (Dispatched by Western Slope

Wain (CO-CRO)

CRC) (CO-CRD)
Western Slope Center (Dispatched by
CRC) (CO-CRD)

Western Slope Center (Dispatched by

Center
(Dispatched by
CRC) (CO-CRD)
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The following graphic shows a sample Save as report view for a Standard
report. The arrow points to the My Folders location.

Save as report view

Specify a name and location for this entry. A report view shares the same report specification as the source report.

Name:

‘My Report View of Resource Status Detail by Qualiﬂcatior‘

Location:
P11y Folders
Select another location...

OK Cancel

To change filter criteria for a Report View
1 In My Folders, click the Report View of your choice.

p 2 Click the Run Report button, complete the Criteria Blocks to suit your
needs, and then click the View Report button.

The following graphic shows the My Folders tab with a listing of saved Report
Views.
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Creating a shortcut to a report

For Standard Reports, creating a shortcut in My Folders provides quick access
to reports you need run on a regular basis. You’ll need to complete the filter
criteria each time you wish to run the report.

To create a shortcut to a report
1 Run the Standard Report of your choice.

2 Click the Add this report drop-down arrow, and then click Add to My
Folders.

3 Complete/modify the Name, Description, and Screen tip boxes as
needed.

4 Under Location, click Select My Folders.
5 Click the Finish button.
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The following graphic shows a sample Request List. The arrow points to the
Add to My Folders option under Add this report.
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Request List
Filter Criteria:
Catalog = Overhead
More than 10 Incidents Cannot Be Displayed In the Fiter Criteria. The selected Incidents will be reflected in the body of the Report.

Dispatch: CO-FTC / Fort Collins Interagency Dispatch Center

Request | RequestStatus | Requested tem
Number

‘ ay ‘lﬁwunhmnnnﬁm ‘Mwnmsuhn ‘So«hln«ds

Incident: 2015 BIC Support - April

o100 Released 11| m——— | Relesed
a0 Released 1 Released
o102 Released 1 i i CO-FTO) ()| Released
103 Released (2 (€OPBOM  Releases
o108 Released 1 (€OPBOM | Released
o105 Released i Released

Dispatch: CO-GIC / Grand Junction Interagency Dispatch Center

Request | RequestStatus | Requested ftem Q| Resource Assignment Name Resource Status | Special Needs

Number
Incident: 2011 Training
o1 Relessed TECHNICAL SPECIALIST (THSP) ”n Released Al i OR D-312 INSTRUCTOR IN

» ‘GRAND JUNCTION, CO - PER KIM BANG.
02 Released HELICOPTER MANAGER, SINGLE n Released
RESOURCE (HMGB)

03 Released (OPERATIONS SECTION CHIEF, TYPE2 mn Released
04 Released EQUIPMENT MANAGER (EQPM) " Released
os Released mn

IMT2 Annual Meeting in Loveland as FACL.

The following graphic shows the New Shortcut wizard. The arrow points to
the My Folders under Location.

. Spedify a name and description - New Shortaut wizard Help ()

Specify a name and location for this entry. You can also specify a description and screen tip.
Name:
|Sh0rtcut to Overhead Request List X |

Description:

Screen tip:

Location:

—— P My Folders

Select another location...

Cancel < Back Next > Finish
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Working with User Community reports

User Community Reports are developed and shared among the user

community. Topics in this section include:

e Overview

e Completing the Prompt screen
e Creating a Report View

e Creating a shortcut to a report.

Overview
Key points about User Community Reports, located on the ROSS - Original tab,
include:
e Actions list the available options when running the report. To perform an
Action, click the button listed to the right of the report you want.
mcggon sorcs © < @ G| punc s cogo- x |
B Pubicrouers | MyFoders
Public Fokders > ROSS > User Community Reports > UC - Resources > UIC - Resource Status EricSYE
e[ ]-[5 |0 |
] | Name & Modified & L Actions
0 m yof esou Yesiho) iy 20, 2014 4:39:45 PM g2 ——F—Set properties
0 & une 29, 2015 1:28:11 PM [ [p}&-85 #ee———+—Run with options
u] October 20, 2014 11:46:13 AM » [E]s# +ere——— Create a report view of this report
u} by pcking Mnemoric Code) 1 » Egimre—f—Schedule
0 s \C, Disp and selected Catalog, Categary, Catekog tem [ » B 88 [iwe. —F— More actions
0 Pre Order Report by Name » B 98 rore.
a 7 » [ i More
; o :u,&mi::ijs‘y\"\’/’_ OB, wl
e Each User Community Report is run using a default format that is
indicated by the icon to the left of the report name.
' Name ¢
XLS format

# Al Dispatch Organizations Affiliations Repart

HTML format

O
E, @n#  All Inc Hosts/Res Provider Organizations By Managing Org Name

0 3> All Organization Affiliations Report

This report provides dispatch affiliations, for all dispatches in ROSS. The report provides organizational affiliations in a hierarchal for,
format. The best way to capture specific sections is to delete all unwanted data as any other data sorting function negatively impaci

This reports provides a listing of Incident Hosts and Resource Providers by Managing Organization Name (i.e. Managing Dispatch).

- “‘ﬁts‘)g?gwrta‘\ﬂs‘ W;amnil ﬁ'ﬂf“ hies as thﬂ exist mqsygj\ooﬂ W@}lfﬁ@_@mﬁ)ﬁmmﬁm%

e Change the default format to suit your reporting needs. Available

formats include HTML, PDF, XML, XLS, and CSV.

¢ Create a Report View of a source report to schedule, change the run
options, and change the default output format of the source report.

e Schedule a Report View to run on a regular basis using the most current

data.

e Forreports generated in XLS and CSV formats, all the features in Excel are

available to suit your reporting needs.

e To manipulate columns and rows of report results, change the output
format of the report to CSV. Selecting this output format will download

11 version 2.16.11
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the file to your computer. The report results do not display on your
screen.

¢ To quickly access a report you use often, create a shortcut in My Folders.

Completing the Prompt screen

The Prompt screen allows you to filter for data to be included in your report.
Prompts are organized and displayed in a top-down sequence. The more
filter criteria you provide, the faster the report will run.

To select a range of values, press and hold [Shift], then click the top-most and
the lowest listed values.

To select more than one value at a time, click and hold [Ctrl], then click the
values you want.

To complete the Prompt screen for a User Community report

Required values display a red asterisk (*) next to its name.

1 Click the User Community Report of your choice.

2 Onthe Prompt screen, complete all required Prompt values, clicking the
Reprompt button after each selection.

3 Click Finish or OK.

The Finish button or OK button appears dimmed until you complete all
required Prompt values.

12
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The following graphic shows a sample Prompt screen for the Incident List by
State and Year.

==X
e ;“Jm https//rossreportsweggov/cognos/c O ~ @& & H (7 Incident List by State and Y. ‘ ‘ ﬁ e “':"

Provide values for the report you are abeut to run.
* Indicates a required field.
2 Points to missing information.

Incident State
Provide a value:

Keywords:
Type one or more keywords separated by spaces.
ico Search[g]
options ¥
Results: Choice:
nserty O

-

Select all Deselect all Select all Deselect all

Incident Calendar Year
Provide a value:
From:

®[2013

() Lowest value

To:
@014

(") Highest value

Cancel B Finish

& v —
3 = »
(<) i | httpsy/rossreportsnweg.gov/cognos/c £ ~ @ & | (7 Incident List by State and .

To change prompt values for your report
1 While viewing the report, click the Run Report button.

2 Complete the required Prompt values as appropriate, and then click
Finish or OK.

The following graphic shows the Cognos Viewer toolbar. The arrow points to
location of the Run button.

IBM Cognos Viewer - Incident List by State and Year

& Keep this version v | 5 s D! @ v 2 addthisreport
=) Resource Ordering and Status System Reports "

\

INCIDENT LIST
For Selected Incident State(s) and Calendar Year
V7 Incident State: CO AND Incident Calendar Year: Between 2013 and 2014

Incident State: CO

Incident Calendar Year: 2013

-..LIWD ‘.‘L’Mli‘w‘}r&ﬁﬂ\e‘“ w_Jlr&Pi})bcw"/\lfwwpe ‘“,XV‘BLRE.M“"EW""« TR v R o WP

To download report results in its default output format

1 While viewing the report, click the Keep this version drop-down arrow,
and then click Download the report.

2 Save the report to a location of your choice.
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3 Complete/modify the Name, Description, and Screen tip boxes as

needed.
4 Under Location, click Select My Folders
5 Click the Finish button.

The following graphic shows the Download the report option under the Keep

this version drop-down arrow.

e Ahnps'z

portsnweggov/cognos/cgi-bin/ £ ~ @ & | My Report View of Resourc...

1BM Cognos Viewer - My Report View of Resource Status Detail by Qualification

(& Keep this verson v | B

D~ | m v 2 addths report » o Watch new versons v

Logoff | & + About

# Add comments

&

(] Email Report...

W Resotirce Ordering and Status System Reports

Z

Filter Criteria:
Dispatch = Craig Interagency Dispatch Center
Catalog = Overhead
Category = Positions
Catalog Item = ENGINE BOSS, ENGINE OPERATOR
Qualification Visibility = Visible

Resource Status Detail By Qualification

page ot 11
Run Dste: 712872015 1019 COT
Senver. rosseports wcg g0v

e W Ve S ve PPN AP i o (CO-COS) G
DS TP o N T N »\,,AM«_,‘MM“MM»/N/ -~

Creating a Report View

Catalog Category Qual Status Qualification Qual | Status Area Available To | Resource Provider/ Owner/ Home Unit Location
Visible
Overhead | Positions Qualified ENGINE BOSS Yes Available GACC Webster, Kerry | Colorado Department of Public Safety | CRAIG-MOFFAT
(CO-GJC) (CO-CDPS) (€AG)
DFPC - Grand Junction Area Office
(CO-GJ5)
DFPC - Grand Junction Area Office
(CO-GJS)
Yes Available Local Mintier, Paul F DFPC - Craig Area Office (CO-CRS) State Office - CO
(CO-CRO) State Office - CO State Forest Service | State Forest

(CO-CO8)
State Office - CO State Forest Service

Service (C0-COS)

Create a Report View when you want to maintain a customized view of the
source report, instead of creating a copy of that source. The Report View
shares the same specifications of the original report, including queries,

prompts, layouts and styles.

You can customize the run properties of the Report View, including prompt
values, schedules, delivery methods, and output formats.

You can also schedule Report Views to run on a regular basis. For more

information see Scheduling Report Views.

To create a Report View

1 Locate the Report you want.

2 Under Actions, click Create a report view of this report.

3 Complete/modify the Name, Description, and Screen tip boxes as

needed.
4 Under Location, click Select My Folders
5 Click the Finish button.
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The following graphic shows the User Community Reports available under

UC - Incident Requests. The arrow points to Create a report view of this
report button.
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[0 [3/» ACEO Requests by Incident Number

June 25, 2015 3:29:21 PM
August 3, 2015 5:11:47 PM =]
August 1, 2015 5:12:47 AM
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The following graphic shows the New Report View wizard. The arrow points
to the Select My Folders option under Location.

- - - . - 3 0n
P,
c .).A https://rossreports.nweg.gov/cognos/cgi-bin/cognos O ~ @ & ” {7 Specify a name
Specify a name and description - New Report View wizard

Specify a name and location for this entry. You can also specify a description and screen tip.

Name:

[Report View of A,C,E,0 Requests by Incident Number x|

Description:

This report provides detailed information for all Aircraft, Crew,
Equipment and Overhead requests by Incident Number. It
currently has a duplicate row problem that will be fixed with the
next ROSS release.

Screen tip:
Location:
——}scirtamtheroonfB Sclect My Folders
Cancel < Back Next > Finish

The Description of the report appears when you set your preference to Details
View.

Creating a shortcut to your report

For reports you need to run frequently, you can create a shortcut and save it
in My Folders.

Create new folders in My Folders to better organize your shortcuts and Report
Views.

To create a shortcut to a report
1 Locate the Report you want.

2 Under Actions, click More, and then click Create a shortcut to this entry.

3 Complete/modify the Name, Description, and Screen tip boxes as
needed.

4 Under Location, click Select My Folders.
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5 Click the Finish button.

The following graphic shows the User Community Reports available under UC
- Incident Requests. The arrow points to More actions.

7-—-—-——--——-—-—’.>.>
EMEN " ivstoss coorsmvcssocomescoronasues £ - 8 G | usic g 1M Cogno

as

1BM Cognos Connection Erin McCormick Log Off

63 pubicroders | wyFokders

|F’UDH( Folders > ROSS > User Community Reports > UC - Incidents > UC - Incident Requests

O [names | Modified &

[ (31> AGEO Al Doc By Incident Number, Request Number & Doc Type August s, 2015 6:56:26 PM
[ B> ACEO Requests by Incdent Number June 25,2015 3:29:21 PV
(] Bk ncident Requests by Tnc GACC, T Disp, Cataloq, Caegry, Catalog tem and Year August 3, 2015 5:11:47 PM
[ Ea® incident Documentation by Incident Number, Request Number and Tnital Incident Date: August 1, 2015 5:12:47 AM

a e
e A S s . A A AR 2 AR
120 est gansaciors by Ingdaci S PO NPV S SPRIIUNPN- - F PN i s

The following graphic shows the Perform an action screen. The arrow points
to Create a shortcut to this entry.

—- 0 8 m —

~ 8 O pertorman action - ACEO . x |8 4

Available actions:

B set properties

B View my permissions.
> Run with optors.
B2 viewthe scheduie

[L1 View run history

2 oy
——— P oo sonaromseny..
B crate a eportvew o hs report
TP add to bookmarks.

Cancel

The following graphic shows the New Shortcut wizard. The arrow points to
the Select My Folders option under Location.

- — W — - e Se— -
2 /‘\ https://rossreports.nwcg.gov/cognos/cgi-bin/cognos p - ﬂ O

Specify a name and description - New Shortcut wizard

Specify a name and location for this entry. You can also specify a description and screen tip.

Name:
ortcut to A,C,E,0 Requests by Incident Number
hortcut to A,C,E,O R ts by Incident Numb x

Description:

This report provides detailed information for all Aircraft, Crew,
Equipment and Overhead requests by Incident Number. It
currently has a duplicate row problem that will be fixed with the
next ROSS release.

Screen tip:

|
Itpcation:

ST mﬂ'salect My Folders

Cancel < Back Next > Finish

The Description of the report appears when you set your preference to Details
View.
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To create a shortcut to a report you are currently viewing

1 While viewing the User Community report, click Add this report, and
then click Add to My Folders.

2 Complete/modify the Name, Description, and Screen tip boxes as
needed.

3 Click the Finish button.

The following graphic shows a sample Incident List report. The arrow points
to the Add to My Folders option under Add this report.

el (=)
° https//rossreportsnweg.gov/cognos/c O ~ @ & | (™ Incident List by GACC, Disp. Y
IBM Cognos Viewer - Incident List by GACC, Dispatch and Year W/Total s LogOff | f& 4 About
= Keep this version v | B G~ | am v 7 addthis replt v
=) Resource Ordering and Status System Reports (@ Add to My Foldey
%’ Jf® Add to Bookma
INCIDENT LIST
Sorted by Incident GACC, Incident Dispatch and Calendar Year
T Inc GACC Org Name\ Inc Disp Org Name (Inc) AND Incident Calendar Year: Between 2013 and 2014 AND Inc Status: Closed
Incident GACC: Rocky Mountain Area Coordination Center~
Incident Dispatch: Fort Collins Interagency Dispatch Centera
Incident Calendar Year: 2013
Inc Numbera. Inc Name Inc Agency Inc Type Initial Date | Inc Status | Lat Long | Total
CO-ARF-000002 2013 ABCD MISC. USFS  Other Support 1313 Closed 403335N 10558W 1
CO-ARF-000003 | 2013 ARF SUPPORT USFS | Other Support 1313 Closed 403335N 10558W 1
CO-ARF-000041 ALEXANDER USFS | Fire - Wildfire 2/7/13 | Closed 402529N 1051443W 1
CO-ARF-000096 2013 ARF JEFFCO HELITANKER SUPPORT USFS | Other Support 4/20/13  Closed | 395430N 10570W 1
CO-ARF-000098 | 2013 ATBM SUPPORT USFS | Program Support - Mgt 4/24/13  Closed | 395450N 105641W 1
CO-ARF-000139  HPI BAER USFS | Emergency Stabiization/BAER | 5/15/13 | Closed 4036 1SN 1052223W 1
CO-ARF-000154 2013 ARF HECM REFRESHER USFS  Training - Proficiency 52313 Closed 40367N 105841W 1
CO-ARF-000186 | HOHNHOLZ USFS  Fire - Wildfire 6/2/13 | Closed 40568N 10631SW 1
CO-ARF-000200 | 2013 JEFFCO ATB SUPPORT-JUNE USFS | Fire - Wildfire 6/4/13 | Closed 39450N 10590W 1
CO-ARF-000254 2013 JEFFCO ATB AIRCRAFT PREPOSITION  USFS  Preparedness/Preposition 6/16/13  Closed 403615N 1052223W 1
CO-ARF-000265  KEYSER RIDGE USFS  Fire - Wildfire 6/17/13  Closed | 395157N 106427W 1
CO-ARF-000272 | JAMES PEAK USFS | Fire - Wildfire 6/19/13  Closed | 39518N 1054121W 1
CO-ARF-000337 DAKOTA HILL USFS  Fire - Wildfire 6/26/13  Closed 395230N 1053230W 1
CO-ARF-000372 2013 JEFFCO ATB SUPPORT - JULY USFS | Other Support 7/1/13 | Closed 395430N 10570W 1
CO-ARF-000416 HELL CANYON USFS | Fire - Wildfire 71013 | Closed 401944N 1052053W 1
CO-ARF-000545 CHAMBERS USFS  Fire - Wildfire 8/5/13 | Closed 403642N 1055133W 1
CO-ARF-000548 2013 JEFFCO ATB SUPPORT - AUGUST USFS | Other Support 8/5/13 | Closed 395430N 10570W 1
CO-ARF-000596  ZIMMERMAN USFS  Fire - Wildfire 812/13  Closed 40410N 1054241W 1
™ PPN i on NPT
CO-ARF-000688 PORTER RANCH 2 USFS  Fire - Wildfire S26/13 . FOH N EL5INNL05 23 46 N 4 A0 o I BN It o) |

JS.TgpeSRage P F P02 UFR0UIN st a e st P

Saving report results in another output format

If you are planning to use MS Excel, the best option is to save the report
results in the CSV output format, which saves the report values in plain text
but eliminates any formatting that may be carried over from the original.

When you open the CSV report in Excel, you may elect to add any additional
formatting as needed, save it in XLS or XLSX as needed, or keep it in CSV.

To save report results in another output format

To use Excel for your reporting needs, save the Report View in CSV format.

1 Run the Report of your choice.

17

version 2.16.11 September, 2018



ROSS User Guide

Reports - running and scheduling reports

Click the Format drop-down arrow, and then click the View in format
option of your choice.

To save in CSV, point to View in Excel Options, and then click View in CSV
Format.

Click Save or Save As, and then save the report to a Folder and File
Location of your choice.

The following graphic shows a sample Incident Resource list. The arrow
points to the View in CSV Format.

\ 5
() ‘. hiips://rossteportsweggov/cognos/ © + @& ¢ ‘ 7™ Incident Resource List - IBM.. X

s Keepthisverson~ | B 15 45 DB~ @ v 2 adtisneportv | By

[NcioeNT_Tvet NTIAL_DATE LATITUDE LoNGTUDE NCIDENT_DESCAIPTION
[other support ovzsaons 1ens wst |3 o7 8 108 32 26
Ctaog | Category | Cetiogtem | pencing | Commites | [ Atincdent | Mob enRoute I
Oveesd | Postors PR FIGHTER o 1 0n ) 1 o 0
e [E5A01
Toll: Postons o 1 1 o 0
Tott Overhead ] 1 1 ] ]
Incident: 2015 FTC Support [CO-FTC-000003]
cioewT_vee WAL DATE aTuoe [lonGTuoE INCIDENT_DESCRIPTION
preparednessPreposiion [o223r015 1335 ST |40 33 350 105 05 08w
Gtig | Clegory | Cabloglem | Pending|  Commited | Reauesthumber | Resurce Asignmentame | Atncident| MobenRate | OWRoster/anest |
Ovemead | Postons  INITAL ATTACK o 100 OO M 1 o 0
bl o 10 I ~(Ca-F10) 1 o ]
A0 M)
o 1046 s @0 1 o ]
DISPATCHER 7 T e | o ]
0
Totl: Pestons o 4 4 ] ]
S e " - 4 o 0
taa RV
2 i, N w )
Sy, A ah,

G View in HTML Format -
tzm View in PDF Format

e

) Resource Ordering and Status System Reports e View In XML Format
/ £ Jlew in Bxcel 2007 Data | i View i Excel Options »
Incident Resource List in Excel 2007 Format
Fitter Criteria:
Catalog = Aircraft, Crew, Equipment, Overhead ] ‘!W in Excel 2002 Format
More than 10 Incidents Cannot Be Displayed In the Filter Criteria. The selected Incidents will be reflected in the body of the Report ¥ View in CSV Format

Incident: 2015 AD Training [CO-GJC-000010]

To run with options

1

On the My Folders tab, click the Run with options button that
corresponds to the Report of your choice.

On the Run with options screen, click the Format drop-down arrow, and
then click the Format of your choice.

Under Delivery, click the Option of your choice, and then click the Run
button.

On the Prompt screen, complete the required Prompt values as
appropriate, and then click Finish or OK.
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Scheduling a Report View

This section explains how to schedule a Report View saved in My Folders.

You can schedule a single report or multiple reports to run at specific
intervals. For example, you can schedule several reports to be run at the end
of every month.

Determine how often you realistically need the report to run. Running the
report as you need it may be more appropriate if you need the report
frequently throughout the day.

To schedule a single report to run on a regular basis

1

Click the My Folders tab, and then click the Schedule button that
corresponds to the Report View of your choice.

On the Schedule screen, click the Frequency tab of your choice, and then
complete the information as appropriate.

To change Options, click the Override the default values check box, and
then select the options you want.

Under Prompt values, click the Override default values check box, and
then click the Set link.

On the Prompt screen, complete the Report Values, and then click the
Finish button.

On the Schedule screen that displays for the Frequency tab you selected,
complete the information as appropriate, and then click OK.

The following graphic shows the User Community Reports available under
UC - Incident Requests. The arrow points to the Schedule button.

™ public Folders  18M Cogro.. |1l 6 48

Exin McCormick Log Off |

August 6, 2015 6:56:26 PM
June 25, 2015 3:29:21 PM
August 3, 2015 5:11:47 PM
August 1, 2015 5:12:47 AM [

NIABLR, [ ea st SIS R, A
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The following graphic shows a sample Schedule screen. In this example, the

report is scheduled to run every Monday.

=IE
e ™ httpsy/rossreportsnweg.gov/cognos/c O ~ @ & | schedule - Report View of .. n
)
[] Disable the schedule Priority: Start:
& Aug 10, 2015 (ol
Frequency: 2:08 PM 5
Select the frequency by clicking on a link.
End:
By Day By Week By Month By Year By Trigger @® No end date
) End by:
eyl Jweekson Aug 10, 2015 &
[¥] Monday [ Tuesday [ Wednesday [] Thursday 2:08 PM| 3

[J Fridey [J saturday [J Sunday
Daily Frequency:

[ Every ~between [ 9 100 AM| S and|[5 o0 M 2

Credentials:
® x )
Options
[[] override the default values
Formats:
Default
Accessibility:
Default
Languages:
Default

Delivery:
Save the report

Prompt values

[] Override the default values
No values saved

3 Cancel

To edit a schedule

1 Onthe My Folders tab, click the Schedule link that corresponds to the

Report of your choice.

2 On the Schedule screen, change the information as appropriate for that

screen and your needs, and then click OK.

To disable a schedule

1 Onthe My Folders tab, click the Schedule link that corresponds to the

Report of your choice.

2 On the Schedule screen, click the Disable the schedule check box, and

then click OK.

To schedule multiple reports to run on a regular basis

Saved schedules appear on your My Folders tab.

1 On the toolbar, click the New job button.

2 Onthe New job wizard, complete the following information and then

click the Next button
- Name

- Description

- Screen tip.

3 On the Select the steps page, click the Add link.
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4 On the Select entries (Navigate) page, click the check boxes that
correspond to the Report(s) you want to schedule, and then click the
Add arrow button.

You can also click Search to locate reports you want to add.

5 |If appropriate, click the Cognos link, and then navigate to Public Folders>
ROSS to add other reports to the schedule, and then click the Add arrow
button.

6 When finished adding all reports to the schedule, click OK.

7 Under Submission of steps, click the Option of your choice, and then
click the Next button.

8 On the Select an action - job screen, click Save and schedule, and then
click the Finish button.

9 On the Schedule screen that displays for the Frequency tab you selected,
complete the information as appropriate, and then click OK.

The following graphic shows a sample My Folders tab. The arrow points to
the New job button on the toolbar.

https;//rossreportsnwcg.gov/cognos/c O ~ @ & ‘ ™ My Folders - IBM Cognos C... ‘ ‘

I .- - i- - ©-

3  publicFolders  MyFolders
My Folders EDNICYEE LB x |0
Entries: |1 -9 (3}
O | Name ¢ Modified & Actions
[0 B My Report View of Resource Status Detail by Qualification July 28, 2015 10:19:58 AM =& » €2 Mo
[0 B2 Report View of AC,E,0 Requests by Incident Number August 7, 2015 11:25:29 AM 1 » 68 More.
[J Ea» Resources Currently On Assignment by Inc GACC, Inc Disp, Incident for selected Catalog, Category, Catalog Item April 9, 2012 12:04:09 PM = » 82 More...
[ Eww Resources Currently On Assignment by Res GACC, Res Disp for selected Catalog, Category, Catalog Item April 2, 2012 1:11:56 PM 1 > 88 More.
[ Bm» RMACC Incident List August 10, 2015 1:09:05 PM
[0 &® Shortcut to A,C,E,0 Requests by Incident Number August 7, 2015 9:54:53 AM 1=
[] Ba» shorteut to Incident List by State and Year August 6, 2015 9:15:34 AM > 82 More...
R N A ANt A AN A AN AN MDA AN UL e 8 . B B BRI

The following graphic shows the New job wizard for naming the scheduled
reports.

Specify a name and description - New Job wizard

Specify a name and location for this entry. You can also specify a description and screen tip.
Name:
|Gopher Gulch Inicdent Reports X ‘
Description:

| Screen tip:
Location:
My Folders
Select another location...
Cancel < Back Next > Finish
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The following graphic shows the Select entries (Navigate) page and the
reports to be added to the schedule from My Folders.

[ESET=>=
(<) Ptps/rosveportswca go/coanos/ © = @ G| 0 selct nties avigate) x| PARE
Select entries (Navigate) - New Job wizard Help™ '
Navigate the folders or search to find the entries to include in your job. Select the entries you want and click the Add button to update the Selected entries list.
Available entries
Cognos > My Folders

Search
Selected entries

ies: - [+]
N s [—-[]
Name

© . O1 > Name
My Report View of Resource Status Detail by Qualification

Report View of A,C,E,O Requests by Incident Number
4 Resourcy

OO
BB A @

es Currently On Assignment by Inc GACC, Inc Disp, Incident for selected Catalog, Category, Catalog Item

No entries.
Resources Currently On Assignment by Res GACC, Res Disp for selected Catalog, Category, Catalog Ttem

Remove

Cancel

Troubleshooting

This section outlines some solutions to issues related to ROSS Reports. Topics
include:

Correcting the undefined error

Modifying your Internet security settings.

Additional topics will be added as needed.

Correcting the undefined error

The undefined error is associated with using the Internet Explorer web
browser.

Message from webpa... ﬁ

undefined

To resolve this issue, you must add nwcg.gov to your Compatibility View
settings.

To add nwcg.gov to your Compatibility View settings
1 From the ROSS Reports Portal page, click Tools, and then click
Compatibility View settings.

On the Compatibility View Settings dialog box, ensure that nwcg.gov
displays in the Add this website text box, click Add, and then click Close.
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Modifying your Internet security settings

Perform this task to download and open an Excel ROSS report on your
computer. You may need to contact your System Administrator to complete
this task.

You will need to perform this task only once.

To modify your computer Internet security settings
1 Start Internet Explorer.
2 On the Tools menu, click Internet options.

3 On the Internet Options dialog box, click the Privacy tab, click to clear
the Tun on Pop-up Blocker check box, and then click the Apply button.

4 Click the Security tab.
5 On the Security tab, click Trusted sites, and then click the Sites button.

6 On the Trusted sites dialog box in the Add this website to the zone text
box, type http://*.nwcg.gov, click and then click the Add button, and
then click the Close button.

Note: On some computers an administrator will be needed to continue
with the following steps if the options are grayed out.

7 On the Security tab, click the Internet icon, and then click the Custom
level button.

8 On the Security Settings - Internet Zone dialog box under Settings, click
the scroll bar to display Downloads.

9 Under Automatic prompting for file downloads, click Enable.

10 Under File download, click Enable, and then click OK to close the
Security Settings - Internet Zone dialog box.

11 Repeat steps #6 through #9 for Intranet icon and Trusted Sites icon.

12 On the Internet Options dialog box, click OK, and then close Internet
Explorer.
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